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We are currently updating the OP Help Center content for the release of OP 14.19 or
OP 19. OP 19 is a member of the certified OP 14 family of products (official version is
14.19.1), which you may see in your software (such as in Help > About) and in the Help
Center tabs labeled 14.19. You may also notice that the version number in content and
videos may not match the version of your software, and some procedural content may
not match the workflow in your software. We appreciate your patience and
understanding as we make these enhancements. 
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When to Use this Report

The Billing Transaction Analysis report is commonly used for:

Financial Summary Reporting
CPT Utilization

Use this report to view your charges, payments, or adjustments for a day, a week, a month, or any

time frame that you wish to isolate your data. For example, if you wish to look at all charges that

were posted into the system for a period of a week, select the date range to be a one week period

(1), select your reference to be Posting (entry) (2), click the Refresh Grid (3), and view the Charge

column (4).  



All daysheeted (archived) transactions for the time period the user requested the system to recall

are displayed.

About Billing Analysis: Transactions
Path: Billing tab > Transactions button > Transaction Analysis >
Transactions tab

This report shows charges, payments, and adjustment transactions for a specified time frame based

off of grid criteria (Charge/Payment date, Posting (Entry), Daysheet, Daysheet ID). The grid is

customizable. You can add/remove columns, group data, and filter data. These reports can be

created and saved for future use. Reports can also be printed or exported to excel. The CPT Activity

Reports (when Charge/Payment Date is selected) are best indicated by date of service. The CPT

Productivity report (when Daysheet is selected) is based on the effective daysheet date and provides

provider productivity breakdowns and insurance plan breakdowns.

Note: More columns are available in the data grid than shown in the map below. The map only
describes the columns displayed in the map. To see the total list of columns, select the
column selection icon in the upper-left area of the grid ( ).



Billing Analysis: Transactions Map

Number Section Description

1 Analyze tab
The Analyze tab displays transactions for particular categories based
on set search criteria. It creates a financial report with each
transaction having its own entry.

2
Transaction
Maintenance
tab

The Transaction Maintenance tab shows transactions where the
logged-in user is either the Rendering, Billing, Supervising, or Service
Provider. Transactions can be updated with the name of the
rendering provider (REND_ADDR_ID) of the charge that was paid in
this tab. Only transactions with a null value are updated from this tab
(where REND_ADDR_ID=null or 0).

3
Reference
dates (range)

The Reference Dates set the start and end date for the displayed
report’s date range. Reports that meet the criteria and fall within the
selected date range are displayed in the standard reports grid.

4
Report
Reference
Criteria

The Report Reference Criteria settings filters the information that is
displayed in the grid after selecting a reference date criteria. The
selections include:

Charge/payment: This report pulls the data based on the
charge date (usually the date of service) and payments and
adjustments according to their payment date (which can be
backdated at the time of posting). The Charge/Payment
displays CPT activity reports.
Posting (entry): This report accesses charges, payments, and
transactions that have a posting date within the time frame
selected. The Posting (Entry) selection displays when a
transaction was attached to the patient account.



Daysheet and Daysheet ID: This grid displays charges,
payments, and adjustments according to the date or ID that
they were processed on a daysheet. The Daysheet selection
displays the CPT productivity in the grid. The Daysheet ID
selection displays the grid based on the OP assigned ID# when
a daysheet is processed.

5
Report
Template
Recorder

Once a grid is customized, you can save the report layout as a
template using the Report Template Recorder. You can Save/Restore
column selections and data filtering for the visible tab.

6
Print/Export
functions

The Print Grid and Export buttons are used to print the grid (using the
Print Grid button) or Exporting the data to Excel (using the Export
button).

7
Refresh Grid
button

The Refresh Grid button displays the latest data in the grid based
upon the Reference Dates and Report Reference Criteria filter
selections.

8
Rendering
Provider

The Rendering Provider column lists the name of the provider for the
transaction.

9 Date of Service
The Date of Service column lists the date of service for the indicated
transaction.

10 CPT
The CPT Code column lists the medical code for the visit on the date
of service.

11 Charge
The Charge column displays the total charges from the provider for
the selected transaction.

12 Patient Owed The Patient Owed column indicates the amount owed by the patient.

13
Insurance Paid
+ Patient Paid

The Insurance Paid + Patient Paid column displays the total amount
paid by the insurance carrier and the patient (adding the Insurance
Paid and Patient Paid columns together).

14 Patient Paid
The Patient Paid column displays the total amount paid by the
patient.

15 Insurance Paid
The Insurance Paid column displays the amount paid by the
insurance carrier.

16
Insurance
Adjustment

The Insurance Adjustment column indicates the amount of the
insurance adjustment that was written off for a particular CPT code.

17 Patient ID
The Patient ID column displays the patient identifier for the indicated
transaction.



18 Daysheet ID The Daysheet ID column displays the daysheet identifier for the
indicated transaction.

Limitations of Billing Transaction Analysis

The limitations to using the Billing Transaction Analysis include:

Determining Payments for specific CPT Codes.
Patient payments based on applied credits; not credits received (the Receipt for Deposit tab
reconciles this).
Dates are critical for Accurate Reporting (though this isn't a true limitation, it is still considered
a limitation).
Counts are based on the number of transactions.

Best Practice Suggestions for Financial Reporting

Use the posting (entry) date as the Reference date.

Avoid backdating.
Run a daysheet daily.  Running daysheets daily protects the integrity of every practice’s
financial data from human error and deliberate adjustment.
Regularly monitor financial and productivity reports.

Version 14.10

When to Use this Report

The Billing Transaction Analysis report is commonly used for:

Financial Summary Reporting
CPT Utilization

Use this report to view your charges, payments, or adjustments for a day, a week, a month, or any

time frame that you wish to isolate your data. For example, if you wish to look at all charges that

were posted into the system for a period of a week, select the Date Range to be a one week period

(1), select your reference to be Posting (entry) (2), click the Refresh Grid button (3), and view the

Charge column (4).  



All daysheeted (archived) transactions for the time period the user requested the system to recall

are displayed

About Billing Analysis: Transactions
Path: Reports menu > Billing Transaction Analysis > Transactions tab

This report shows charges, payments, and adjustment transactions for a specified time frame based

off of grid criteria (Charge/Payment date, Posting (Entry), Daysheet, Daysheet ID). The grid is

customizable. You can add/remove columns, group data, and filter data. These reports can be

created and saved for future use. Reports can also be printed or exported to excel. The CPT Activity

Reports (when Charge/Payment Date is selected) are best indicated by date of service. The CPT

Productivity report (when Daysheet is selected) is based on the effective daysheet date and provides

provider productivity breakdowns and insurance plan breakdowns.

Note: More columns are available in the data grid than shown in the map below. The map only
describes the columns displayed in the map. To see the total list of columns, select the
column selection icon in the upper-left area of the grid ( ).



Billing Analysis: Transactions Map

Number Section Description

1 Analyze tab
The Analyze tab shows transactions for particular categories based
on set search criteria. It creates a financial report with each
transaction having its own entry.

2
Transaction
Maintenance
tab

The Transaction Maintenance tab shows transactions where the
logged-in user is either the Rendering, Billing, Supervising, or Service
Provider. Transactions can be updated with the name of the
rendering provider (REND_ADDR_ID) of the charge that was paid in
this tab. Only transactions with a null value are updated from this tab
(where REND_ADDR_ID=null or 0).

3
Reference
dates (range)

The Reference Dates set the start and end date for the displayed
report’s date range. Reports that meet the criteria and fall within the
selected date range are displayed in the standard reports grid.

Report

The Report Reference Criteria settings narrow the information
displayed in the grid after selecting a reference date criteria. The
selections include:

Charge/payment: This report pulls the data based on the
charge date (usually the date of service) and payments and
adjustments according to their payment date (which can be
backdated at the time of posting). The Charge/Payment help
to displays CPT activity reports.
Posting (entry): This report accesses charges, payments, and



4 Reference
Criteria

transactions that have a posting date within the time frame
selected. The Posting (Entry) selection displays when a
transaction was attached to the patient account.
Daysheet and Daysheet ID: This grid displays charges,
payments, and adjustments according to the date or ID that
they were processed on a daysheet. The Daysheet selection
displays the CPT productivity in the grid. The Daysheet ID
selection displays the grid based on the OP assigned ID# when
a daysheet is processed.

5
Report
Template
Recorder

Once a grid is customized, you can save the report layout as a
template using the Report Template Recorder. You can Save/Restore
column selections and data filtering for the visible tab.

6
Print/Export
functions

The Print Grid and Export buttons are used to print the grid (using the
Print Grid button) or Exporting the data to Excel (using the Export
button).

7
Refresh Grid
button

The Refresh Grid button displays the latest data in the grid based
upon the Reference Dates and Report Reference Criteria filter
selections.

8
Rendering
Provider

The Rendering Provider column lists the name of the provider for the
transaction.

9 Date of Service
The Date of Service column lists the date of service for the indicated
transaction.

10 CPT
The CPT Code column lists the medical code for the visit on the date
of service.

11 Charge
The Charge column displays the total charges from the provider for
the selected transaction.

12 Patient Owed The Patient Owed column indicates the amount owed by the patient.

13
Insurance Paid
+ Patient Paid

The Insurance Paid + Patient Paid column displays the total amount
paid by the insurance carrier and the patient (adding the Insurance
Paid and Patient Paid columns together).

14 Patient Paid
The Patient Paid column displays the total amount paid by the
patient.

15 Insurance Paid
The Insurance Paid column displays the amount paid by the
insurance carrier.

16
Insurance
Adjustment

The Insurance Adjustment column indicates the amount of the
insurance adjustment that was written off for a particular CPT code.



17 Patient ID
The Patient ID column displays the patient identifier for the indicated
transaction.

18 Daysheet ID
The Daysheet ID column displays the daysheet identifier for the
indicated transaction.

Limitations of Billing Transaction Analysis

The limitations to using the Billing Transaction Analysis include:

Determining Payments for specific CPT Codes.
Patient payments based on applied credits; not credits received (the Receipt for Deposit tab
reconciles this).
Dates are critical for Accurate Reporting (though this isn't a true limitation, it is still considered
a limitation).
Counts are based on the number of transactions.

Best Practice Suggestions for Financial Reporting

Use the posting (entry) date as the Reference date.

Avoid backdating.
Run a daysheet daily.  Running daysheets daily protects the integrity of every practice’s
financial data from human error and deliberate adjustment.
Regularly monitor financial and productivity reports.


